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COADE, CAESAR II Celebrates 20 Years
(by: Tom Van Laan)
In 1984:
•

a second superpower (the Soviet Union) was presided over by
Yuri Andropov

•

prominent in American popular culture were “The A Team”
(television), Culture Club (music), and Haing Ngor (movies)

•

computer technology raced along, with the introductions of IBM’s
PCJr and Apple’s Lisa 2

•

very few had yet heard the words Internet, SUV, hip hop, or
reality TV
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1984 seems like a very different time than that which we experience
today. But there were some similarities:
•

despite record budget deficits, a sluggish economy, and
American soldiers under fire in a Middle Eastern nation
(Lebanon), George Bush (Sr.) was elected on a national
ticket to a second consecutive term in office (as VP)

•

COADE’s CAESAR II reigned as the leading PC-based
pipe stress analysis software

Yes, it is true – COADE and CAESAR II are now 20 years old, and
this month – December 2004 – we celebrate the anniversary of the
first sale of CAESAR II, a sale of two licenses made to SOHIO,
whose pipe stress engineering department only owned one PC!
Since 1984, the world has changed considerably, and companies
and products have come and gone (for example, SOHIO, the first
CAESAR II customer, ceased to exist as an independent entity less
than three years after that initial CAESAR II purchase).

COADE Staff, ca. 1990

But one thing has not changed – COADE has continued to grow and
move forward, adapting to changing technology, changing
engineering requirements and expectations, and the changing
business climate and marketplace. We are proud to be where we are
today, 20 years after that initial sale:
•

serving more than 22,000 licensees in more than 6500
companies in 65 countries

•

having experienced 19 years of increasing sales

•

providing not just CAESAR II, but also CADWorx,
PVElite/CodeCalc, and TANK (premier products in the
world of AutoCAD-based plant design, pressure vessel
analysis, and API 650/653 analysis and design, respectively)

•

reaching the world through our 50-country distribution
network

Thanks for this success are due to all of the employees who have
contributed to COADE since the beginning – there are too many to
name here. But more importantly, thanks are due to all of the
customers and prospects over the years who have been willing to
take the time to consider our offerings and give them a fair evaluation.
Without the confidence that you all have shown in us, we would not
be here to celebrate our 20th.
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Selected COADE Staffers Today, Older and Wiser

New Features in PVElite
Version 2005
(by: Scott Mayeux)
PVElite 2005 represents a significant product update over the
previous version. One of the most notable changes in the new
version is an updated user interface. The Element Input Data,
Design Constraints, Title Page Data and Wind/Seismic have all
been organized into a tabbed property view. The tab containing
the Input data along with all of the other toolbars are dock able and
now retain their locations in between sessions. Much of the input
data now appears in a grid-based format. The up and down arrow
keys along with the tab and enter key allow movement in between
the data fields. The new input screen is shown below.
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A few other features of this new version are:
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•

Increased the number of input points for India’s Response
Spectrum Input

•

Added Selection of Plate Densities for Platforms

•

Added Piping Detail Input with the Mass/Equipment Detail

•

Enhanced the Wind Analysis Output for several wind
codes including ASCE-7 /93/95/98/02

•

Added Flange Thickness Input field in the flange dialog

•

Input for Additional Static Pressure

•

Thick Expansion Joint Analysis for UHX based Exchanger
Designs

•

Sort able Nozzle Schedule Report with Weld and Pad
sizes

•

Plus all of the new CodeCalc features and many others

•

ASME Code 2004 Updates, including UHX and the
Appendix 26 updates

CodeCalc 2005 New Features

•

All new Material Database Editor for ASME, PD:5500
and EN-13445

The new features added to CodeCalc 2005 include:

•

EN-13445 Material Database

•

PD:5500 Yield Stress Database

•

Updated Output Processor

•

Enhanced Word Generation in the Output

•

Metric Bolts have been added per TEMA, British
Standards and South African Standards

•

Several Structural Steel Databases have been added
including Korean/JIS, British, German, South African
and Australian. These databases will be available for leg
and stiffening ring design.

•

ASME Steel Stack Design per STS-2000 has been
implemented

•

External Corrosion Allowance is accounted for

•

Nominal Thickness Input is available

•

Stress Analysis of Openings in Skirts

•

The Units and Design Code can be changed easily from
the new Units toolbar

•

Australian Wind Code

•

European Wind Code

•

Mexican Seismic Code

(by: Mandeep Singh)

1) ASME Ed. 2004 code updates, including UHX tubesheets,
thin expansion joints (bellows kind) and the material
databases.
2) Implemented the Appendix 9 Jackets in the Shell/Head
module. These jackets could cover the shell (completely
or part of it) and/or the head. Various types of jacket
closures are also available. The program computes the
required thicknesses of jacket, jacket head and closure
bar. A screen shot of the jacket input is shown below:
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3) Incorporated thick expansion joints (flanged and flued
type) into ASME UHX tubesheet module. The thick
expansion joint was previously available in the TEMA
tubesheet module.
4) On-screen display of error messages, warnings and
important results is available for the ASME UHX and
TEMA tubesheets. This speeds up the design of the
tubesheet and expansion joint. See a sample below:

5) Added analysis of a vessel on 2 support lugs. Analysis for
vessel supported on more than 2 lugs was previously
available.
6) Added TEMA Metric, British and South African Metric
bolt look up tables in flange, basering, tubesheets, floating
head and Leg-Lug modules.
7) Updated Output processor.
8) Enhanced Microsoft Word generation in Output processor.
9) Enhancements were made to the user interface for the
Flange module including the on-screen display of results.
See the screen shot below:

10) Added an option to use the full bolt load (W*ab) in the
flange design.
11) Added inputs for the partition gasket thickness and the
nubbin width. In earlier versions of the program, the
gasket thickness and nubbin width of the main gasket was
being used for partition gasket.
12) In Annex-G module, added an option to print the
membrane stress at nozzle edge.
13) Modifications to the treatment of full strength tubetubesheet joint in the tubesheet modules.
14) Enhancements to the program for network users.
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CAESAR II Version 4.50
3D HOOPS Graphics Tips
(by: Nadia Strikovski)
Starting with CAESAR II version 4.50 the 3D HOOPS Graphics
has incorporated all of the features of the “standard” graphics
engine and supports many new features that make it superior to the
standard graphics engine. As a result the standard graphics interface
has been eliminated from the Piping Input.
CAESAR II utilizes the third party HOOPS 3D graphics engine.
This provides a number of benefits over the “standard” in-house
designed graphics. There are a number of resources available (the
COADE web site and documentation) to become familiar with the
3D graphics features (listed at the end of this article).
The HOOPS 3D graphics engine uses a real-world paradigm of a
fixed model and moveable camera with the camera moving around
the model as if it were attached to a string whose other end is tied to
the center of the model. Zooming in and out is achieved by adjusting
the string length and orbiting is accommodated by moving the
camera along the outside of an imaginary bubble. The model
doesn’t move, but rather it is the user’s viewpoint (the camera) that
moves. This concept allows for the real-time interaction with the
model without spending computer-processing time on recalculation
of the model’s position or projection.
This article is devoted to covering the most commonly asked 3D
Graphics-related questions and to highlighting the most useful
and/or new features. It begins with the most basic options to get the
user started, continues with CAESAR II version 4.50 related tips,
and ends with a troubleshooting section.
How to Display a Model in a Single Line/Center Line Mode
The initial (default) view for a new job is displayed according to
the “display options” defaults (which can be set on a per job basis)
that include:
•

rendered (shaded 3D) view

•

restraints shown

•

XYZ compass shown

•

isometric view

•

tees and nozzles highlighted

•

orthographic projection
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To switch the view to display the single line mode, click the
[Centerline View] toolbar button. It is located in the group of five

What is “Zoom to Selection?”

display mode buttons

Graphics view that include clicking on an element while the
[Select by Single Click] option is active, finding an element in the

[Gouraud Shading

(rendered mode)/Hidden Lines/Wire Frame without hidden
lines/Two Line Mode/CenterLine View] on the first row of
toolbar buttons, towards the right. Alternatively, pressing the “V”
key on the keyboard will toggle the views in following order:
Gouraud Shading (rendered mode) -> Two Line Mode -> Center
Line View.
How to Zoom the Model
There are several options to zoom the model. Interactive zooming
is achieved by clicking the
[Zoom] toolbar button and then
moving the mouse up or down while depressing the left mouse
button. The keyboard [+] and [-] keys may also be used to zoom
the model in and out, once the
clicked.

[Zoom] toolbar button has been

There are several ways to highlight/select an element in the 3D

[Find Node] option, and browsing through the

model with the
spreadsheets

in the Piping Input. Clicking the

[Zoom to

Selection] toolbar button will bring the selected element to the
center of the view and zoom to it. Note: If nothing is highlighted,
the [Zoom to Selection] button is disabled.
[Find Node]
This option is especially useful together with the
operation. The element found may be small compared to the entire
model, or may be hidden behind other pipe elements or components.
The [Zoom to Selection] is available directly on the Find Element
dialog by enabling the corresponding check mark or from the
toolbar after the Find Node operation has been performed.
Rotation/Orbiting

The best way to zoom to a particular area of the model is to use the
mouse to draw a “rubber band box” around the desired area.
Simply click the
[Zoom to Window] toolbar button, then leftclick on one corner of the desired area, and stretch a box diagonally
to the opposite corner of the area while still holding the left mouse
button down. When the left button is released, the model will zoom
to the selected area.
[Zoom to
To see the entire model on the screen, click the
Extents] toolbar button. Use the [Zoom to Extents] button instead
of [Reset Plot] to view the entire model if you want to preserve all
the custom highlighting and the current view.
Zoom to Window

Reset Plot

Zoom to Extents

Zoom to Selection

Interactive Zoom

Display Mode Buttons

Interactive rotation of the model can be accomplished by clicking
the
[Orbit] toolbar button. Once this mode is activated, the
model can be rotated by using the mouse or the arrow keys on the
keyboard. To use a mouse for rotating the model, click the left
mouse button on the model (the bounding box will be drawn to
outline the model boundaries); while holding down the left mouse
button, move the mouse around to the desired position/angle.
When mouse button is released, the view will be updated and the
bounding box will disappear. If the bounding box is not visible,
check the corresponding box on the User Options tab of the Plot
Configuration dialog (see the “3D Graphics Configuration”
paragraph for details).
Note: During the rotation operation (only) for speedup purposes
the model may be changed to the wireframe or single line mode
view or some of the geometry details may become missing or
distorted. The actual conversion will depend on the size and
complexity of the model. Once the rotation is complete, the model
will return to its original state.
Another way of (automatic) orbiting the model is through the Gyro
operator. It can be activated by pressing the [G] keyboard key.
Upon pressing the [G] key, the model will perform a full 360degree rotation in the plane of view. This is useful to have a quick
look around the model.
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How to Rotate the Model Around X, Y, or Z Axis

How to Resize Restraints, Hangers

Because of the concept of moving of the camera around the static
model, it is not always feasible to orbit the model “about one of the
global axis” (for example, preserving the vertical elements vertical)
if it is in an ISO view or in any view off axis. This is because the
direction cosine of the camera in an ISO view is (1,1,1), which is a
little off center (the “Y-vertical model axis” is rolled forward
slightly), and the camera moves around an imaginary bubble with
respect to the vertical or horizontal axis of the flat screen/display.

In the CAESAR II 3D graphics the size of restraints and hangers is
relative to the pipe diameter. For fairly large models with long pipe
runs, the size of restraints may become too small to see clearly
when zoomed to the extents of the model. The size of the symbols
for restraints and hangers may be manually adjusted to become
larger or smaller by clicking on the black arrow to the right of the
relevant toolbar button and selecting the size option from the drop
down menu.

To orbit around a true Y-axis (assuming “Y” is up), first, choose
[Orbit] as your operator and set the view to the Right or Left
view (either by pushing the appropriate view button
or
typing [X] or [shift] + [X]). Alternatively, the Front or Back
views can be selected (by clicking
buttons or typing [Z] or
[shift] + [Z]). This will ensure that the model vertical axis is
aligned with the vertical axis of the screen. Then use the “right”
and “left” arrow keys on the keyboard. This will move the camera
around our mythical bubble’s equator, which is perpendicular to
the y-axis.
Similarly, aligning any of the model’s horizontal axes (X or Z)
with the screen horizontal axis (by selecting an appropriate
orthogonal view) and using the “up” and “down” keyboard arrow
keys will move the camera around the bubble over the “prime
meridian” providing the rotation about the selected model horizontal
axis.
Using the Mouse Buttons and the Mouse Wheel
If the mouse is equipped with a middle wheel, it can help in
reducing the time to manipulate with the model graphics.
Determine the operation desired and highlight the corresponding
toolbar button. Then hold down the left mouse button and the
mouse movement will cause the model to respond in the selected
manner. Additionally, while holding down the middle mouse wheel
any mouse movement will generate the [Pan] operation.
Alternatively, spinning the middle mouse wheel up/down will
[Zoom] the model in and out of the view around the mouse pointer
location. Thus, using the middle mouse wheel may eliminate
additional time spent clicking the [Pan] and [Zoom] toolbar buttons
without actually switching the current operation.
In addition, the right mouse button can be used to display a
“context menu” and an “Operations” sub menu containing toggle
switches for zooming, panning, and rotating the model. The Plot
Configuration dialog may also be found by right mouse clicking
anywhere on the view, and selecting Properties -> Display Options.
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How to Change Color of Node Numbers, Pipe, Components or
Background
Most of the display options can be adjusted by clicking the
[Change Display Options] toolbar button. The various tabs that
this Display Options dialog controls include: basic graphics colors,
font selection and size for text data, user startup settings, and
visibility (the degree of transparency). Alternatively, the same Plot
Configuration dialog may be found by right mouse clicking
anywhere on the view, and selecting Properties -> Display Options.
The Basic Graphics Colors Tab will be accented here: Selecting
any item in the list (e.g. Nodes), then clicking the [Change] button,
displays a standard Windows color selection tool. Selecting the
desired color and clicking [OK] changes the color of the selected
item to the new color. The rotating spring hanger is used to actively
preview the color selection combinations before altering the entire
plot window. This is a useful tool to prevent selecting unsatisfactory
color combinations.
The colors may be reset to the CAESAR II defaults (as defined in
the configuration) by clicking the [Reset All] button.
Note: The state of each model is maintained individually (job
related), in an XML data file (job-name.xml) in the current data
directory. Upon invoking another input session, CAESAR II reads
this XML file and restores the 3D graphics to its previous state.
This means that changing any of the colors in the CAESAR II
Tools->Configure/Setup file will not immediately affect/change
the current job graphics if it has already been viewed. For the
settings to take effect, start the graphics, access the Display Options
Dialog and click the [Reset All] button.
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How to Limit the Amount of Displayed Information
If the model is large (element-wise) or has many similar looking
branches, it may become difficult to review relevant information.
The 3D HOOPS Graphics engine provides a number of useful
tools to limit the amount of displayed information or to quickly
navigate through the model.
The
[Find Node] option allows the user to find a specific
element by providing it’s “From” and “To” nodes. The “Find
Node” option also allows searching for any node number and will
highlight the element(s) containing this node number.
The
[Range] option is used to plot only those elements that
contain nodes within the range specified by the user. This is
particularly helpful when attempting to locate specific nodes or a
group of related elements in a rather large, often symmetrical
model, or when reviewing a model created by someone else.
Upon clicking the

[Range] toolbar button, a dialog with a
sorted list of all defined node numbers with check boxes will be
displayed. The user may click each individual node, select a range
of nodes to display using standard Windows techniques, or use
From-To node fields to add displayed nodes to the list. Upon
clicking [OK] button, only nodes with a check mark will be
displayed on the view. Note: The Find Node option may not work
properly for the part of the model that is “hidden” by the Range.
The corresponding message will also appear in the status bar.
In many cases, the elements/node numbers are not defined
consecutively. Thus, it may be easier to cut/slice a piece of model
at a certain location to see more details on one side of the cut. For
this procedure, use the
[Insert Cutting Plane] toolbar button.
When the cutting plane appears, use its handles to move/rotate the
plane as desired. If the cutting plane’s handles are not visible, or a
display goes blank, the view may be zoomed too close for the plane
to operate correctly. Use the
[Zoom to Extents] toolbar button
to zoom out the model; then click the [Cutting Plane] button again
for the handles to appear. To turn the cutting plane off, right mouse
click anywhere on the view and select “Delete Cutting Plane”
from the menu.
Annotating and Documenting the Model
It is often necessary to add a graphical representation of a model to
the CAESAR II stress reports or to make screen shots for
presentation. The 3D HOOPS Graphics view can be saved as a
bitmap by clicking the
[Save Image to TIF File] toolbar
button. The model geometry, colors, highlighting, as well as
restraints and most of the other options will be transferred to the
bitmap.
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There are times when annotation is needed to clarify the model
image. This could be useful to highlight problem areas, or write a
brief description of the model. The annotation may be especially
useful in the output processor. There are two basic kinds of
annotation available: quick snap and semi-permanent.
The first type is the

[FreeHand Markup] that provides

four options: “Free Hand”, “Circle”, “Rectangle”, and “Annotate”.
It is not attached to any element in the model and is destroyed upon
any manipulation to the model (like zoom or pan). It may be used
to add a short description of the model to the graphics image for
printing or saving to a bitmap.
The second type is the

[Annotate Model] toolbar button that

draws a text box with a leader to an element of the model. The
annotation with a leader stays with the model on zoom, pan, rotate,
and use of any highlight options. It also gets printed to the printer
and saved to the bitmap; however, it does not get transferred to the
HTML file and is not saved upon exiting the graphics.
Another way to save an image is from File->Save as Web Page, or
alternatively, typing the combination of [SHIFT] + [H] keyboard
keys. This creates three files in the current data directory using the
current job name: *.HTML, *.HSF, and *.HMF. Opening the
*.HTML file displays the corresponding *.HSF file. Note: This is
an interactive file that allows zooming, panning and orbiting. The
advantage of the Web Page file is its ability to be viewed on any
computer, without the need for the CAESAR II software (it requires
a web browser and an internet connection to download a viewing
plug-in control the first time the file is opened on that computer).
This option is particularly useful to save an animated dynamics
model to a file for presentation or review.
Working with Piping Input and Graphics Windows Opened
CAESAR II v4.50 allows input and edit of model data with both
the Piping Input and Graphics windows opened simultaneously.
This is beneficial for larger models and/or slower video cards
because the graphics require some time to get re-generated every
time they are opened. It also allows the user to see the model
“growing” as new elements are added. If the monitor resolution
allows, both input and graphics windows may be positioned sideby-side. However, in many cases the graphics window needs to be
resized so small that it prevents a clear view of the model. In such
cases the graphics window may still be kept open, but partially
covered/hidden by the input screen.
To work in the spreadsheet with the graphics window open in the
background, from the Piping Input, click the Graphics button.
Then in the Graphics window click the

[View Input

Spreadsheet] button on the toolbar to display the Piping Input
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again. Clicking the same button again will toggle the Input screen
on and off. If the button state is already “pushed on”, then you can
access the input spreadsheet by clicking the appropriate icon on
the Windows task bar.
Highlight Options Available in the Input Graphics
Often it is necessary to review the piping model in the context of
certain data; for example, by diameter, wall thickness, temperature
or pressure. These operations are available from the 3D Graphics
toolbar.
Upon clicking the corresponding toolbar button, the display is
updated to show each value with a different color. A color key
legend is included on the plot in a separate, resizable and moveable,
window. This is a good way to verify that specific changes have
been made at the appropriate locations in the model.
The first group of buttons includes Materials
Wall Thickness

, and Insulation Thickness

, Diameters

,

. The second

group includes Temperatures
and Pressures
with up to
nine available choices. The final group will highlight and color
code elements where Displacements
Uniform Loads

, External Forces

, and/or Wind/Wave Loads

,

are defined. In

the last case, the legend will be displayed in tabular format with the
ability to scroll through the nine available vectors.
Note: While in the described highlighted mode, the model can still
be zoomed, paned, and rotated. Any orthographic projections and
single line/volume modes can still be used without affecting the
model highlighted state.
Note: When the model is printed, the legend text will appear either
in the upper left corner of the page or on the next page. However,
the legend window/text cannot be saved to an external source (like
TIFF or HTML).
Highlight Options Available in the Static Output Graphics
The Static Output 3D Graphics engine has the same general
capabilities as the Piping Input Processor. Additional capabilities
include showing displaced shapes in the final condition (the
[Deflected Shape] toolbar button) and in intermediate steps (the
[Grow] toolbar button) with the ability to set the deflection scale,
highlighting and zooming to maximum displacements (
toolbar buttons), restraint loads (Forces

or Moments

toolbar buttons), and code stresses of the model (
[Overstress],
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[Max Code Stress] toolbar buttons).

The major feature of the Static Output 3D Graphics is its ability to
display a graphical distribution of stresses in color (a shaded
contour plot) by value (the
button) and by percent (the
toolbar button).

[Stress Colors by Value] toolbar
[Stress Colors by Percent]

When using the Stress Colors options, the legend is also displayed
where each color corresponds to a certain stress boundary value or
percentage of the code stress. These options are used to quickly see
the distribution of the code stresses in the model for a particular
load case. The colors and corresponding stress levels can be
manually adjusted by user.
Another useful feature of the Static Output Graphics is its ability to
display any report (displacements, restraint loads, and code stresses
by load cases) directly on the graphics view. Clicking the
[Show Report Viewer Grid] toolbar button displays a “grid
view” of the mentioned reports in a separate, resizable, moveable
window. It has bi-directional highlight option: clicking a node or
an element on the Report Viewer grid (when Select by Single
Click mode is active) will highlight the corresponding element on
the graphics view, and will zoom to the selected element if the
corresponding Zoom to Selection mode is on; similarly, clicking
an element on the graphics view will highlight the corresponding
data row in the report view of the Report Viewer Dialog.
Troubleshooting
Repeating consecutive zooming, orbiting, and/or panning operations
as well as using such limiting display information options like
Range, may bring the model into a “difficult to understand” state.
It may also be desirable to quickly remove any highlighting and
other effects from the view. In such cases the
[Reset Plot]
toolbar button can be used. Upon clicking the button, the model
will return to its default state. There is no need to physically close
and re-open the graphics view window.
As with any software, the HOOPS 3D Graphics Engine has its
internal limitations. Occasionally, the HOOPS 3D Graphics view
may become corrupted after performing some operations. This
may include very close zoom, using a “walk through” operator
from the “top” view or backwards, among others. Since the
current state of the model is maintained in the *.XML file, such
problems are easily solved by simply deleting this XML file. First,
close the Graphics processor window as well as the Piping Input.
To delete the *.XML file, open Windows Explorer, navigate and
open the data directory (where the CAESAR II input file in question
is located). Find the XML data file (job-name.xml) and delete it.
Then return to the piping input. Upon invoking the 3D Graphics
engine, the model will be displayed in the CAESAR II default state
and the XML file will be recreated from the configuration settings.
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In some instances, the appearance of the graphics view, its ability
to perform certain operations (like pan or zoom), or to display
anything at all may be related to the video card in use and/or the
video drivers being up-to-date (first, ensure you have the latest
drivers for the video card in use). The problem here is that the 3D
acceleration on many video cards is far from superior. In most
cases the problems are not related to CAESAR II or HOOPS
Graphics, but rather to the OpenGL implementation on the card. If
displaying the 3D graphics causes a lot of problems, go to Tools>Configure/Setup from the CAESAR II Main Menu, select the
Plot Colors tab, and remove the check mark for “HOOPS Graphics
use OpenGL” to use the non-accelerated MSW drivers. Then “Exit
w/Save.” Upon returning to the graphics, the display problem
should go away.
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CAESAR II Version 5.00
(by: Richard Ay)
The development work on CAESAR II Version 5.00 is nearing
completion. Version 5.00 will include many changes and updates,
including:
•

If zooming or rotating operations cause too much distortion to the
model view, try reducing “3D Frame Rate” on the 3D Viewer
setting tab of the Configuration dialog.

The piping input processor has been revised to provide a
combined showing both the graphics and the spreadsheet.
The new piping input processor has integrated the Piping
Error Checker, and access to the configuration module
has been provided. For debugging and problem solving,
relevant sections of the spreadsheet can be torn off and
placed on the graphics pane, allowing the spreadsheet to
be hidden for larger graphics display. Additionally,
sections of the model can be graphically selected and then
modified.

If all the steps above fail, check the following websites to ensure
your video card isn’t listed as one with known problems. If it is, the
only remedy is to change the video card:
•

•

Solidworks graphics board test results <http://
www.solidworks.com/pages/services/
VideoCardTesting.html>

•

Techsoft (the HOOPS 3D engine developers) graphics
board test results <http://developer.hoops3d.com/
graphicscards/graphicscards.html>

Additional 3D HOOPS Graphics Resources:
From www.coade.com select Support->Reference Material, then
select CAESAR II from the Technical Articles drop down box.
The articles to review are “CAESAR II Version Usage Tips”, Vol
1, Vol 2, and Vol 3.

•

The static output processor has been enhanced to provide
users with the ability to create custom, reusable reports.
The expanded static output control dialog is shown in the
figure below.

From www.coade.com select Support->Animated Tutorials. The
tutorials that cover graphics usage include “3D Graphics Usage”
and “Reducer Modeling” (that also illustrates the simultaneous
operation of the input spreadsheet with the input graphics).
The CAESAR II Users Guide (supplied with the installation CD or
available electronically from the CAESAR\C2_Docu directory or
from the CAESAR II Main Menu option Help->Online
Documentation) also has detailed information and toolbar button
descriptions, in relevant chapters (Piping Input, Static Output,
Dynamic Output, Structural Steel Modeler) under the corresponding
3D/HOOPS Modeler Sections.
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•

New piping codes incorporated: EN-13480, GPTC/192,
Z662 Ch 11

•

Updated / revised piping codes: B31.1, B31.3, B31.8,
B31.11, ASME NC, ASME ND, CODETI, TBK 5-6.

•

Flexibility analysis can now be performed using the hot
modulus associated with the operating temperature.

•

The ability to perform dynamic analysis optionally using
a consistent mass matrix. This obviates the need re-mesh
the model for better mass distribution.

•

Added Ameron Bondstrand FRP pipe specification files.

•

Added PiHASA (Spain) spring hanger table.

Collaboration with CADWorx IP
(by: CADWorx Development Team)
Earlier this year, COADE Inc. released a new product that carries
the ease of use and collaboration possible with CADWorx P&ID to
a whole new level. The new product, CADWorx Internet Publisher
(IP), allows users of CADWorx P&ID to export entire projects to a
web based format that can then be shared with customers, designers,
engineers, and even maintenance personnel. Collaboration,
distributive design, and information sharing in plant design have
been promised by software vendors for years. It has finally come
of age with the introduction of CADWorx IP.
What is collaboration? When a project begins, many designers
and engineers must work together and coordinate how a project or
process will be constructed. Many fundamental steps must be
taken to ensure complete and safe designs. Equipment must be
sized and designed. Processes must be routed and instrumentation
must be applied. Currently, engineers and designers perform these
important steps via paper. An engineer will mark up a paper copy
of the design and then have the designer or draftsman make the
necessary changes in the drawings.
With CADWorx IP, the user can publish a project to a web site, a
shared network server or even a CD-ROM. Other engineers, who
may not have the facilities to view AutoCAD drawings, can view
the drawing using only a standard browser via a DWF format. All
important documentation will be available to the reviewer some of
which may need to be revised. Any available reports will be
automatically exported by CADWorx IP which can then be used to
review line lists etc.
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The most important benefit of CADWorx IP is the ability to give
all project stakeholders (clients, subcontractors, vendors, regulators,
etc.) a complete P&ID project so that they might be able to review
and revise the design. Project team members can even view them
from a company’s internal website with the information posted
daily for all concerned parties to view. Customers can also redline
the design with comments and then provide it back to the engineering
staff to apply the changes.
When the process/project has been completed, maintenance
personnel can use the same system to maintain the process
equipment. Any kind of information such as equipment
specifications, catalogs, stress analysis reports etc. can be stored
with a CADWorx P&ID project and thus any type of information
can be published with CADWorx IP.
For example, if the
maintenance personnel change something for required regulatory
requirements, it can be redlined for engineering to make the
necessary modification to the drawings. All that is required is a
computer with Internet Explorer and one of Autodesk’s DWF
viewers.
The export process is straight forward and easy. The user can start
by selecting the project configuration file for the P&ID project
they wish to export. The entire export process is completely
customizable with the user having complete control on what is
exported. Just following a standard windows wizard, they can
select which drawings, tables, columns are to be exported.
CADWorx IP can even export any reports the user created in the
project database. If any loop drawings were created, those too are
available for export.
CADWorx IP supports several viewers available from Autodesk,
Inc. Some of these are available as a free download while others
require license. More information on the kinds of available
viewers is supplied with the program.
CADWorx IP shares the CADWorx philosophy of keeping things
simple and the evidence is clearly visible with the final product.
The exported P&ID drawings are laid out in an easy to use and
intuitive manner allowing for quick access to all information
accompanying the drawing as shown in the illustration below.
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P&ID Drawings are displayed
in a tree structure.
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Information about P&ID
components are displayed here.

COADE’s Plant Design Strategy:
Seeking the Integrated Total Solution
(by: Tom Van Laan)
In 1996, COADE introduced CADWorx Pipe, our AutoCADbased plant design application to our roster of products – a roster
that up to that point had included only Plant Engineering (analytical)
applications. Since that time, we have continued to expand our
plant design offerings (which today include CADWorx Plant, P&ID,
Equipment, Steel, and Internet Publisher) — all the time with our
eye firmly on a goal of which many of our customers may not be
aware.
The addition of plant design solutions to our existing Plant
Engineering solutions probably gave the impression that we were
moving toward offering a ‘total solution’; one that encompassed
all aspects of plant design and engineering. On the surface, that is
true, but our true strategy has really been so much more than that.

Documents attached to P&ID
components are shown here.

P&ID Drawings are
displayed here.

The easy to use panel display and its integration with Internet
Explorer ensure that virtually no training is required for someone
to use CADWorx IP. On the left panel, a tree display shows the
various P&ID drawings, loop drawings and reports that were
exported. The upper middle panel shows all the information
associated with each P&ID component. Any documents attached
to the project are also automatically available through the lower
middle panel. And of course, the drawing itself is available
complete with zoom/pan controls etc. View a complete sample at
http://www.coade.com/cadworx/ipv4.
CADWorx IP is available now! It is included at no additional
charge in the CADWorx P&ID Professional package. If you
would like to more information about this product, please contact
your local dealer or sales@coade.com.

The ‘Total Solution’ is Born
In the past most companies and end users asked for a tool that
would aid them in designing and constructing the entire project.
We in the plant design software industry developed a catch phrase
for this elusive Holy Grail — the ‘total solution’. From the
inception of the first plant design system the goal of the developers
was to deliver that ‘total solution’. But the question was how?
There were many possible routes to reaching that goal.
Delivering a ‘Total Solution’
The challenge facing all developers was not only to deliver a
‘Total Solution’ that was marketable (and believable) on that basis,
but also one that not only met the needs of the organization as a
whole, but also those of the individual disciplines. Means of
achieving such a solution included:
•
•
•
•
•

Recommendation
Partnering
Re-branding
Acquisition
Development

Recommendation
This is the weakest way to provide a component of the total
solution – the developer simply points a user in the direction of a
supplier who can provide what is needed. In this case any interaction
between the developer’s system and the application being
recommended is generally on a very basic, and perhaps coincidental,
level.
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Partnering
This method is slightly stronger than recommending a system, and
usually involves a situation where the developer’s system and the
complementary application may have undergone some optimization
to facilitate interfacing between the two, and where the
complementary application may even be resold or supported by the
developer. Typically the partnering arrangement does not affect
the look and feel of either solution but may provide for the
interaction features deemed most important.
Re-branding
This solution usually gives the end-user a nice fuzzy feeling that
they have purchased an application from the same developer that
has done such a good job providing the rest of their system, but in
reality it is usually no better than partnering. In most cases the
methodology, workflow and command structure is still at variance
to that of other the other components of the ‘Total Solution’
supplied to the end-user. Re-branding is simply a marketed form
of partnering.
Acquisition
This shows commitment on the part of the developer, not only a
financial commitment, but also a commitment to take on the not
inconsequential development and marketing roles for the product.
The aim here is to own the technology for the long term, with plans
to integrate it into the developer’s suite of software. The plus is
that this provides the tools the market requires much more quickly,
in effect by buying knowledge that would otherwise take much
longer to develop internally. The minus is that in the short term the
applications may not have the look and feel of the existing offerings
from the developer.
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After speaking to end users and brainstorming internally, we came
to the conclusion that this is not what was really wanted. Yes, end
users wanted it all, but they also wanted the parts to work as a
whole and to interface at their most natural level.
Therefore what the market was asking for was not the ‘total solution’
that developers were giving them — but what they really wanted
was an integrated total solution.
Moving Towards Integration
As software applications mature they acquire a user base that is
comfortable with the workings and performance and those
applications. For true integration the trick is to take what users
already do and what they already produce and make that same
information accessible to other interested parties involved in the
work process.
We can therefore differentiate the ‘total solution’ as opposed to the
‘integrated total solution’ thus:
A Total Solution is a solution that has all the tools required to
complete a task or project.
An Integrated Total Solution is a solution that not only has all the
tools required to complete a task or project, but also a solution
where information is shared between all of those tools to the extent
that the benefits of one project team member’s work can be accessed
by all other project team members.
The integrated total solution exemplifies COADE’s vision. We
believe that our future, and the interests of the end users of our
products, is best served by concentrating on integration. This is
not a new focus but one that has steadily become part of the culture
of the company.

Development
Only One Way to Get There?
This is the best of the best. The benefit is that users get a product
developed by their chosen developer that has the look, feel, and
interactivity that they expect. The minus is development from
scratch takes a lot of time, resources, and money to pull off – in fact
a fortune can be spent, especially over the time that it may take the
developer to play ‘catch-up’ with other software vendors.
Where the Total Solution fails to deliver
In General the ‘total solution’ delivered by developers in this
industry comprises a combination of all of the above strategies.
This is unavoidable but what we have seen being offered to the
market in many cases is no more than a bag of parts with minimal
interface between those parts – in other words, no more than a way
to ‘check the boxes’ on the brochure indicating the solution’s
capabilities.
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Although developing applications in house gives the best content
control and therefore the best chance of making integration easier,
this does not always make it the best decision.
At some point in the process a developer has to admit that what
they can bring to the market may not be the best solution, or it may
not be accepted widely enough, for it to be a viable product to
bring to market. In those cases honesty dictates that partnerships,
re-branding, or acquisition are better strategies all round. An
example of this is seen in COADE’s relationship with NavisWorks,
whose products (Roamer, Presenter, Publisher, and Clash) have
been integrated with CADWorx Plant to perform the design review,
presentation graphics, and clash detection functions for the COADE
plant design suite.

December 2004
Integration in practice
COADE’s initial foray into integration resulted in the link between
our CAESAR II pipe stress program and our CADWorx Plant
design suite. These two applications were naturals for integration
as the work done in both design and analysis has such a direct and
immediate impact on each other. What made this integration
special (easier) was the fact that as both applications are developed
by COADE, the developers of each program could work very
closely (both figuratively and literally) together. The success of
this integration, which allows the stress engineer and piping designer
to work exactly as they always have, but now they can benefit
directly, in as transparent a form as possible, from the work done
by their counterpart across the departmental divide – encouraged
us to work toward a completely integrated solution.

COADE Mechanical Engineering News
•

The first quarter 2005 will see the release of CADWorx
Steel Professional. This new application will have
enhanced capabilities over CADWorx Steel including
interfaces with CAESAR II, ROBOT, and other structural
analysis products.
•

•

PVElite and CADWorx Equipment
CADWorx Equipment users can now seamlessly import
Pressure Vessel and Exchanger designs that have been
designed with PVElite. This link will be extended to a bidirectional link in the first quarter 2005.

•

CADWorx Plant and CADWorx P&ID
Intelligent information from CADWorx P&ID projects
can be read by CADWorx Plant to set parameters for any
line that needs to be modeled. Line number, line size,
specification, service, area, unit etc. can all be set
automatically in CADWorx Plant simply by selecting a
line from CADWorx P&ID.

•

CADWorx Internet Publisher and CADWorx P&ID
CADWorx Internet Publisher can publish all data
(including linked documents) from a CADWorx P&ID
project to the internet, intranet, or CD and allow access to
that information to anybody with any standard browser,
regardless of lack of CAD platform, applications, or skills.

•

CADWorx Plant or P&ID and Access, SQL Server, or
Oracle
CADWorx Plant seamlessly links to any ODBC compatible
database to produce bills of materials or reports (line lists,
etc.) available to any application that supports similar
standard databases.

•

COADE’s Integration Path and Vision
This drive for integration did not stop at the obvious link between
CADWorx Plant and CAESAR II. We have continued (and will
continue) to pursue:

CADWorx Steel Professional and CAESAR II

CADWorx Plant and Isogen
CADWorx Plant interfaces with Alias’ industry standard
software to produce automatic isometrics.

•

CADWorx Loops and CADWorx P&ID
CADWorx Loops produces automatic instrument loop
diagrams from the CADWorx P&ID project database.

Quantifiable Benefits of Integration
Obvious benefits of an integrated solution are evident in the fact
that data reuse leads to work hour savings and reduced mistakes
incurred during manual or semi-automatic data transfer. In fact one
study (by Construction Excellence, www.m4i.org.uk) makes the
claim that over 80% of inputs are wastefully repeated due to lack
of integration. Another study reports that the annual cost of
rectifying construction defects caused by errors in transferring
information to detailed drawings (and by operatives subsequently
being given incorrect instructions) approaches to $2 billon in the
UK alone.
This indicates that one of the best ways to save costs is not by
investing in faster machines or increasing the efficiency at each of
the engineering, procurement, or construction stages of the process
but by making sure information input is made useful at each
subsequent stage of the process.
An Integrated System, a Distributed System

CADWorx Plant and CAESAR II
At the moment CADWorx Plant and CAESAR II can bidirectionally transfer models and other information
between the two programs.

A major benefit of a system that shares all information is that it
allows work flow tasks to be broken up and distributed to different
project team members – this may be done on a regional or discipline
level, between EPC and owner/operator, or in many other ways. If
all team members can see and benefit from the work of all others,
there is no need to face the choice of either having to assign the
entire project design to a single individual (or single group) or risk
clashes and other incompatibilities between different team members.
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This shows that distributive design may well be the true payoff for
an integrated engineering system.
Distributive Design the Future
So what is the end game? What does COADE feel end-users will
be expecting (and demanding)?
First – the end game is that that we must cut the loss of data from
one stage of the design build process to another. This should be a
main focus of any engineering, procurement or construction
company looking for the best efficiencies.
Secondly – Developers should not live in a bubble. We owe it to
the market to increase the integration between the applications that
we develop AND to link to industry standard packages supplied by
other software developers.
Third – Look not only at what a package can do for one project
team member but also what benefits the application’s integration
can deliver to other team members both at the same stage in the
process and for those downstream.
Your call
We hope that ‘check box’ features and benefits will not be the only
criteria upon which you select your plant design solution and that
integration and distributive design will now also be criteria
considered on your path to implementing your ideal plant design
system. For those who do, we thank you in advance for putting
your faith in COADE’s product line – your first step to true
integration and design efficiency.

With the publication of Addendum 3, the API-650 code has replaced
the above sections with a single statement that instructs the engineer
to refer to Section 3.12 (a new section) for bolting guidelines.
Section 3.12 provides minimum requirements for anchorage, through
Table 3-12 which lists 7 loading conditions. For each loading
condition, the code provides and equation for the net uplift as well as
the allowable anchor bolt stress. The 7 loading conditions to be
addressed are:
•

Design pressure

•

Test pressure

•

Failure pressure

•

Wind load

•

Seismic load

•

Design pressure + Wind

•

Design pressure + Seismic

These new bolting requirements are addressed by TANK Version
2.50. TANK will evaluate these 7 conditions, when applicable,
and provide a concise bolting report to the user. A typical bolting
report is shown in the figure below.

TANK 2.50 and New Bolting
Procedure
(by: Richard Ay)
With the publication of Addendum 3 to the 10th Edition of API650, API has significantly changed the bolting requirements for
tanks. Prior to this addendum, bolting requirements were mentioned
in a number of places in API-650:
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•

Section 3.11 for overturning stability defined a bolt load

•

Appendix E for seismic evaluation defined a bolt load

•

Appendix F for internal pressure evaluation provided an
allowable bolt stress, but offered no other guidance.

This report shows that only the seismic conditions are applicable to
this particular tank, and as a result, 16 bolts, 2-1/2 inches in
diameter are required. (The “zero” values in the “uplift” column
indicate that either no load was defined, i.e. pressure, or the load
was too small to produce uplift, i.e. wind.)
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Users who have not acquired Addendum 3 should do so as soon as
possible. If you are not using Addendum 3, your tank bolting does
not meet the requirements of the current API-650 code.
This change in Addendum 3 means that a tank designed to a
previous edition of the code may now require bolts, whereas before
it didn’t. Users need to be wary of code changes. The same model
run with TANK Version 2.40 may yield different results than when
run with TANK Version 2.50. Because of this “code change”,
enough design information must be provided to TANK, in case
bolts must be designed. The input dialog for bolting information is
shown in the figure below.

It has been a common practice for engineers to simply replace the
area removed by attaching a reinforcing pad or frame around the
opening. However the actual problem is more complex than just
adding material for area replacement.
Consider the following situation. Shown below in figure 1 is a
skirt with two openings.

A

B

Figure 1
At the cutting plane A-B metal has been removed. However, let us
first consider the case of a skirt without any openings shown in
figure 2. In this case, the section properties are given by:
A = π r2

I xx =

This dialog shows the minimum amount of information that is
necessary for an analysis. Even if you think your tank doesn’t need
anchorage, this data is required. An increase in wind speed could
always change the outcome, requiring anchorage.

Stress Analysis of Skirt Supports
with Openings

I yy =

Where:
D
t
Ixx
Iyy
Zxx
Zyy

π D3
8

πD
8

3

Z xx =
Z yy =

π D2
4

π D2
4

is the mean diameter
is the skirt thickness
is the second moment of area about X-X
is the second moment of area about Y-Y
is the section modulus about X-X
is the section modulus about Y-Y

(by: Ray Delaforce)
Process towers are usually supported on skirts. Often, because of
the bottom drain outlet, for venting (for example hydrogen) it is
necessary to have openings or nozzles in the skirt. This is especially
true in the case of access openings that are fairly large in diameter.
Cutting holes in skirts has a weakening effect. The weakening is
caused by the reduction in the section properties where the crosssectional area and section modulus are reduced at any horizontal
cutting plane passing through the opening.

Figure 2
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Notice that the value of Ixx and Ixx are equal, and that the center of
area – or centroid – passes through the center of the circle in figure
2.
Once we cut holes in the skirt the situation becomes more complex.
In figure 3, we see a skirt with two access opening:
The centroid moves to a new position as indicated by the checkered
circle. The next task is to find the principle axes. For a non
symmetrical section, the principle axes Y’Y’ and X’X’ rotate to a
new position, passing through the new centroid. This task is
accomplished in PVElite by performing a numerical integration.
The new values of Zxx’ and Zyy’ are then computed, the lesser of
which is the new section modulus.

Figure 4
Performing the computation manually is extremely tedious, but as
the computer does not tire out, it is the ideal platform for this task.
Before we look at an example of a particular skirt configuration, let
us digress for a moment to look at how pressure vessel codes
handle this situation.
The German AD 2000, and European EN 13445 codes provide a
procedure for determining the weakening effect of a single opening
in the skirt. The computation to determine the section properties at
the widest part of the opening is not given in the code, but this is
not very difficult to compute by hand (although still tedious). As
far as we are aware, no code addresses the situation where there are
multiple obround openings in a sloping skirt. As this situation
arises from time to time, we have included this analysis in PVElite
as an optional method available to the user.

Figure 3
Sloping Skirts with obround access openings:

Let us now consider an example for a tower with a tapered skirt
with obround openings located at various heights in the skirt. The
input screen for the openings looks like this:

Now consider the case of a sloping skirt, with obround access
openings. In this case the situation is different. We can use the
same method to determine the section properties through any
horizontal plane. Looking at figure 4 this is what we mean:
The cutting plane A-B now passes through several openings. As
the distance of the cutting plane from the bottom of the skirt
increases, the skirt diameter decreases.
Now, PVElite has the task of finding the location of the cutting
plane such that it returns the weakest section properties. PVElite
searches for the location of the smallest value of Zxx’ or Zyy’
whichever is the lesser.
This indicates there are three openings in the skirt. The diagram
that goes with this dialog is shown below.
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The three openings are located at 0O, 110O and 230O around the
skirt at varying heights.

Access Opening: 2 Cuts through the bottom of the skirt
Access Opening: 3 Cuts through the bottom of the skirt
Note:

If the opening cuts top or bottom, this is not a problem
This becomes a ‘Sentry Box’ type Opening

Layout
Cntr. Dist. Obround
Diameter
Angle
From Bottom Cntr-Cntr
mm.
Deg.
mm.
mm.
——————————————————————————————————————————————————————
1
39.3701
0.0000
23.6220
7.8740
2
35.4331
110.0000
11.8110
19.6850
3
37.4016
230.0000
15.7480
5.9055
Access No

Opening
Details

Access Opening Frame Dimension
Access No
Width
Thick
mm.
mm.
——————————————————————————————
1
1.9685
0.3937
2
1.9685
0.3937
3
1.9685
0.3937
Interference check:
Access
Acess

We have created a tower with a tapered skirt, with a wind load that
subjects the skirt to a bending moment and shear force.
Without going into the details of the tower and wind forces, we can
examine the output generated by PVElite for this skirt. Notice that
the program computes three sets of section properties namely:
•
•
•

At the position where the user has entered a height value
(1000 mm) see above
At the location of the least section modulus (the weakest
section)
At a location that give the least cross-sectional area.

The program computes the bending stress at the weakest section
(at the least section modulus Z). It also checks the ligaments
between the openings to ensure there is no interference between
adjacent openings.
This is a sample of the computed output:
Skirt Support Analysis Generally per AD 2000 and EN 13445-3: 2002:
Item: Node 10 to 20
Note:

All dimensions at the cutting height are at the Mean Diameter and, the
whole skirt must be ONE piece.

This is a Conical type Support Skirt
Wider at the Bottom
Half Apex Angle of the skirt
a
Skirt Mean Diameter Bottom End DzBot
Skirt Mean Diameter Top
End DzTop
Skirt Analysis Thickness (Corr.)
ez
Skirt Height
H
Applied Moment - Top
of Skirt M4t
Applied Moment - Bottom of Skirt M4b
Weight Above the Skirt
F4

Pitch
Ligament
mm.
mm.
————————————————————————————————————————————
1
2
2043.4139
1058.6173
2
3
2249.5925
1303.5631
1
3
2043.4139
1058.6173
INTERFERENCE CHECK:

Interference
Check

No Interference Detected between Openings

The Minimum Pitch between openings
is:
The Minimum Ligament between Openings is:

2043.4139 mm.
1058.6173 mm.

Section properties for the user input cut height [User]
Number of Openings At Critical Height = 3
Access No

Cut Angle 1
Cut Angle 2
Deg.
Deg.
——————————————————————————————————————————————————
1
-25.6270
25.6270
2
87.6375
132.3625
3
221.7481
238.2519

Where the
openings cut the
Skirt

The points for integrating Ixx, Iyy is as follows:
FROM THETA1
TO THETA2
Deg
Deg
——————————————————————————
25.627
87.638
132.362
221.748
-121.748
-25.627
Hght of the Section Cutting Plane H
Diameter at the Cutting Plane
d
Rotation of Principle Axes
a
Centroid Position in X direction
g
Centroid Position in Y direction
h
Principle Moment of Intertia
Ixx
Principle Moment of Intertia
Iyy
Distance to Extreme Fibre
ybar
Distance to Extreme Fibre
xbar
Minimum Section Modulus
W4
Metal Area at the Cutting Plane
A4

1000.000
2119.056
-24.282
-88.510
-93.965
10297201664.000
9088164864.000
1183.165
1103.155
8238349.500
17536.994

mm.
mm.
Deg.
mm.
mm.
mm**4
mm**4
mm.
mm.
mm.^3
mm²

Skirt
Details
1.432 Deg
2169.056 mm.
2019.056 mm.
3.175 mm.
3000.000 mm.
28335248.000 N.mm.
59060612.000 N.mm.
33031.203 N.
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Section properties at weakest section modulus [Z]
Skirt Slenderness Ratio [r/L]:
= 732.731 / 36000.000 = 0.244

Number of Openings At Critical Height = 3
Access No

Cut Angle 1
Cut Angle 2
Deg.
Deg.
——————————————————————————————————————————————————
1
-27.8876
27.8876
2
85.1045
134.8955
3
203.9478
256.0522

Weakest
Section

New section
Centroid
Moment Increment at Centroid [DeltaM]:
= Weight(F4) * Eccentricity (e)
= 33031.203 * 26.471 = 10496672 N.mm.

The points for integrating Ixx, Iyy is as follows:
FROM THETA1
TO THETA2
Deg
Deg
——————————————————————————
27.888
85.104
134.896
203.948
-103.948
-27.888
Hght of the Section Cutting Plane H
Diameter at the Cutting Plane
d
Rotation of Principle Axes
a
Centroid Position in X direction
g
Centroid Position in Y direction
h
Principle Moment of Intertia
Ixx
Principle Moment of Intertia
Iyy
Distance to Extreme Fibre
ybar
Distance to Extreme Fibre
xbar
Minimum Section Modulus
W4
Metal Area at the Cutting Plane
A4

Location of the Skirt Centroid at critical height [e]:
ex = -20.349 : ey = -16.930
e = Sqrt(ex² + ey²) = Sqrt(-20.349 ²+-16.930 ²)
= 26.471 mm.

622.193
2137.946
31.694
-20.349
-16.930
9056479232.000
8047504384.000
1074.275
1096.770
7337467.000
14988.990

mm.
mm.
Deg.
mm.
mm.
mm**4
mm**4
mm.
mm.
mm.^3
mm²

Axial Stress at Residual (Weakest) Surface Area [Sigma]:
Downwind Side:
= -( M4 + DeltaM ) / W4 - F4 / A4
= -( 52688248 + 10496672 ) / 11373.097 - 33031.203 / 14988.990
= 5.921 N./mm²

Bending Stresses
Upwind Side:
= +( M4 + DeltaM ) / W4 - F4 / A4
= +( 52688248 + 10496672 ) / 7337467 - 33031.203 / 14988.990
= 10.31 N./mm²
Maximum Allowable Compressive Stress [SC]:
= From External Pressure Method = 20.000 N./mm²

Least Section
Modulus Z

Section properties at least metal area [A]

Extra Moment
resulting from
movement of
centroid

This value will depend
upon the code employed
Maximum Allowable Tensile Stress [ST]:
= Min ( 1.2 * Design Stress , 0.90 * Yield Stress )
= Min ( 1.2 * 137.900 , 0.90 * 239.946 ) = 165.480 N./mm²

Number of Openings At Critical Height = 3
Access No

Cut Angle 1
Cut Angle 2
Deg.
Deg.
——————————————————————————————————————————————————
1
-27.8622
27.8622
2
85.1233
134.8767
3
203.7489
256.2512

SUMMARY:
Actual
Allowable
Ratio
Compressive
Tensile
Compressive Tensile
Comp.
Tens.
N./mm²
N./mm²
N./mm²
N./mm²
————————————————————————————————————————————————————————————————————
5.921
10.31
31.30
165.480
0.189
0.062

The points for integrating Ixx, Iyy is as follows:
FROM THETA1
TO THETA2
Deg
Deg
——————————————————————————
27.862
85.123
134.877
203.749
-103.749
-27.862
Hght of the Section Cutting Plane H
Diameter at the Cutting Plane
d
Rotation of Principle Axes
a
Centroid Position in X direction
g
Centroid Position in Y direction
h
Principle Moment of Intertia
Ixx
Principle Moment of Intertia
Iyy
Distance to Extreme Fibre
ybar
Distance to Extreme Fibre
xbar
Minimum Section Modulus
W4
Metal Area at the Cutting Plane
A4

591.895
2139.461
32.103
-19.196
-15.586
9073734656.000
8044569600.000
1074.319
1095.862
7340867.000
14979.139

Results are satisfactory
Please note the following:
mm.
mm.
Deg.
mm.
mm.
mm**4
mm**4
mm.
mm.
mm.^3
mm²

Analysis of the Section at Weakest Section Modulus [Z min]:
Please Note: The following calculations only concern the minimum.
Modulus [Z]. Section properties for the minimum area [A],
and the user cut height [User] are not included below
Find the moment acting at the Critical Height [M4]:
= (Mbottom - Mtop)*(H - CutHeight)/H + Mtop
= (59060612 -28335248 )*(3000.000 -7466.313 )/36000.000 + 28335248
= 52688248 N.mm.

Radius of Gyration of Skirt at 4-4 [r]:
= Sqrt( Min( Ixx, Iyy ) / Area )
= Min( 21758.301 , .80475E+10 ) / 14988.990 )
= 732.731 mm.

18

The Minimum Ligament between Openings = 1058.617 mm.
The user must assure that the stresses in the ligament area are acceptable.
PVElite 2005 ©1993-2005 by COADE Engineering Software

Specifying Hillside Nozzles
in PVElite
(by: Ray Delaforce)
Many users have asked us about the ‘Layout’ button on the nozzle
dialog box. This is the button in question:
For some reason there has been confusion as to how this works,
especially in the case of hillside nozzles. So let us start from
scratch.
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Reference Angle and Offset:
Reference angle: This is the DIRECTION in which the nozzle
POINTS. This is a very important point. In figure 4 note that the
angle is where the nozzle is pointing. The nozzle can be anywhere
in space, but only its direction is the reference angle. The datum
from which the reference angle is taken is the 0 degree point on the
shell. The angle in which the nozzle points can be anywhere from
0 deg to 360 deg. The angle is measured counter clockwise from
the 0 degree datum point.

Figure 1
Consider a vertical vessel, and let us look at the cylindrical shells.
Looking from the top, the angular positions around the shell are as
shown here in figure 2:

Figure 4
The offset distance is the distance from the centerline (or axis) of
the nozzle to the centerline (or axis) of the shell. Now, the offset is
also considered in the counter clockwise. In figure 4, the nozzle
centerline is above the shell centerline. This is what is meant by
the fact that it is also counter clockwise. If the nozzle were below
the shell axis, the offset dimension would be a negative number.
Layout Angle
Figure 2
The angle around the shell increases in the counter clockwise
direction. Let us now consider the case of a hillside nozzle. Once
we have pressed the Layout button, we get the screen shown in
figure 3 below. Click the ‘Hillside Nozzle’ radio button as shown.

This is the angle at which the centerline of the nozzle cuts through
the shell wall. This is illustrated in figure 5:

Figure 5
Figure 3

The layout angle is computed by PVElite once it has been given
the reference angle and the offset distance. This value is important
for placement and interference determination.
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The computed layout angle will be found on the main nozzle
dialog screen (computed from the reference angle and offset
distance. This is shown in figure 6.

Figure 6
Hillside Nozzles on Heads
In the case of heads, the same principle applies as in the case of
hillside nozzles in a cylindrical shell. However, a hillside nozzle
installed in a head can be entered in two different ways. Firstly,
figure 7 illustrates hillside nozzles in a head:
The axes of the nozzles are all parallel to the axis of the head.

December 2004
There are two methods of locating a hillside nozzle on a head. The
first is to give the reference angle and distance from the center of
the head – the offset. Here are the two dimensions as shown in
figure 9a and 9b:

Figure 9a

Figure 9b

Figure 9b shows how the location of the nozzle can be specified in
Cartesian coordinates by giving the X and Y dimensions. This is
very useful as nozzles are often specified in this manner. In this
case the offset and reference angle are calculated by PVElite.
Nozzle Projection
Look at figure 10.

Flange
ho
Proj

ho is computed from the Proj
dimension

Weld

Figure 10
Figure 7
If the nozzle is being installed in a head, pressing the ‘Layout’
button will reveal this dialog screen as illustrated in figure 8:

Enter the dimension ‘Proj’ from the head weld line to the face of
the flange, and PVElite will compute the dimension ‘ho’, the
distance from the where the centerline of the nozzle intersects the
inner surface of the head to the end of the nozzle where it is welded
to the nozzle flange. When you close the layout dialog screen, the
nozzle dialog screen will show the computed value of ‘ho’ as
shown in figure 11.
In this way, the tedium of computing the projection of the nozzle is
relieved.

Figure 8
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After review of the technical reference manual you will be able to
write data via the ODBC interface.
So why bother?
Why trouble oneself with this? Admittedly I agree CAESAR II has
a very rich set of report writing options in place for input and
output data that do not involve ODBC. However some uses that I
have found handy are… Specialized custom restraint summaries to
other parties, extracting input data for model review…
Figure 11

Conclusion
The purpose of the layout button on the nozzle dialog screen is to
simplify the placement of hillside nozzles. PVElite performs all
the computations necessary for this task without the user having to
be concerned about the angle of the nozzle relative to the component
surface, or the elongation of the hole in the component. PVElite
does it all.

What is ODBC?
(by: John C. Luf, Consultant, Cleveland, OH)
CAESAR II has had the ability to write model data out to ACCESS
since V4.2. Many users probably never bothered to go through the
cumbersome set up required to utilize this feature. V4.5
automatically sets up the PC it is being installed on for this feature.
ODBC is the acronym for Open Data Base Connectivity (a Microsoft
development). The goal of ODBC is to make it possible to access
any data from any application, regardless of which database
management system (DBMS) is handling the data. So as you can
see this is a standard across the Microsoft Empire.
A pipe flex model is nothing more than data and its results are also
data, so the ODBC is a tool for handling data.
How does it work?
The use of the ODBC transfer is handled via the data base wizard
found under the tools section of the menu bar. A review of the
technical reference manual under the interfaces section will show
how to use the ODBC transfer. (Note you do not have to set up a
DSN as mentioned in the technical reference the installation process
should have already accomplished this for you.

Input review…
One of the things that always is handy is to know what the block
structure of a model is like. In the old days (15-20 yrs ago) model
analysis was a big deal and models were constructed and maintained
with religious zeal manually. These days models may be
automatically extracted from 3D models, models or parts of models
may be shared in collaborative engineering efforts, and nowadays
lines which have been analyzed are just as much subject to revision
and maybe more so than lines which have not been analyzed. What
this means is that seldom do models progress from node 10 to node
10000 in a smooth logical sequence. When trying to edit such a file
lack of knowledge of the block structure can add to your headaches.
What’s a block and what’s block structure???? An example is
listed in the table below:

From
10
20
30
40
50
70
80
90
150
160

To
20
30
40
50
60
80
90
100
160
170

Comment
Start of File, from Pump1 Discharge

End at tee/ Header
Bypass around Control Valve
End Bypass
Etc. Etc.

Block 1

Block 2
Start of
Block 3

Simply extracting the element data via the ODBC and then exporting
it to Excel (very simple to do within ACCESS) the from and to
node data then writing a formula to compare node numbers will
allow you to easily find nodal breaks and define the files block
structure.
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“Splash Screen ACESS Switchboard form”

There are other uses that I won’t go into but surely a creative
person will be glad to look into these possibilities.
Output reports:
Currently CAESAR II has a wide variety of output reports that can
be saved as word documents or text files. (See pg 243 of the online
users guide) But lets say you want something else… Well without
ODBC you could edit the other files cutting, pasting, and deleting
information into it manually. This has numerous drawbacks time,
and introduction of errors come to mind.
However writing the data you require to an ACCESS database
and then doing some work in ACCESS allows easy customization.
One could combine Node Number, Node name, Restraint Model
Coordinate, Restraint Reactions, and Displacements into an
ACCESS database. Then using the tools in ACCESS you can
easily create queries reports and control panels, as you need to.
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“Custom Report”
Summary:
I have attempted to simply make people aware of this feature,
which can be used quite simply to export data into ACCESS.
Once in ACCESS a knowledgeable person can then easily be
quite creative in how the incoming data is manipulated and
eventually presented.
I did not intend to have this article serve as a how set of instructions
in the use of ACCESS or EXCEL. In order to be at the peak of
effectiveness in the business of piping flexibility analysis persons
involved should be knowledgeable with these wide spread tools
and how they may assist in the manipulation of data.
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B31.3 – 2004 and CAESAR II
by: Dave Diehl
Introduction
By now, everyone should know that new editions of the ASME
B31.3 Process Piping Code are delivered on a two-year cycle with
no updates or addenda issued between editions. This new program,
started with the 2002 Edition, replaces the previous three-year cycle
with annual updates. The content of the 2004 Edition was pretty
much defined at the Code Committee meeting in the fall of 2003.
The galley proofs for the 2004 Edition were reviewed by all Code
Committee members and should be out soon. This new two-year
delivery cycle packs numerous of changes into each new Edition.
This article reviews the technical changes in B31.3 – 2004 Edition
that apply directly to CAESAR II.
The number of Code changes that directly affect stress calculation
is impressive. Obviously, the Code Committee now acknowledges
that the implicit understanding and experience associated with hand
calculations has been totally replaced by engineers’ reliance on
computer modeling and analysis software. In the past, individuals
resolved ambiguities to their own satisfaction and utilized B31.3
paragraph 300(c)(3)1 as they saw fit. Today, commercial software
applications have replaced the step-by-step approach to piping
system evaluation. Now it is the authors of commercial computer
tools that, at best, resolve these ambiguities or, at worst, mask them
further. The background and knowledge of the authors of today’s
commercial computer tools define the code’s gray areas, in effect
displacing the judgment of the engineer using the tools 2 .
Understanding this, the Code Committee is providing more explicit
direction to address these old issues and incorporates the new
analysis capabilities readily accessible to all.
Stress Range Reduction Factor, f
The limit for the expansion stress range, SA, is defined by the
equations (1a) and (1b). All references in this article will be to B31.3
except where noted. Equation (1b) shows SA = f [1.25( S c + S h ) − S L ] .

This equation can be broken down into its three components. The
1.25( S c + S h ) term addresses shakedown and low cycle fatigue; S L
reduces this limit to prevent ratcheting failure3; and f, the stress
range reduction factor, incorporates high cycle fatigue considerations.
Now, assuming that the basic allowable stresses, cold and hot, are
based on material yield at these temperatures4 then Sc= 2/3 SY (SY is
material yield stress) and Sh=2/3 SY at temperature. The limit for low
cycle fatigue range is the sum of yield stress at the “cold” temperature
and the yield stress at the “hot” temperature or (SY + SY at temperature).
Exceeding this limit will result in material yield in every cycle and,
in short order, failure. In our terms, this converts to (1.5Sc+1.5Sh).
Theory then predicts low cycle fatigue failure when the stress range
exceeds 1.5(Sc+Sh). The Code permits only 1.25(Sc+Sh), thereby
providing a factor of safety of 1.50/1.25. Markl’s work gives us f,
the stress range reduction factor, in equation (1c). Equation (1c)
reads f = 6.0( N ) −0.2 ≤ 1.0 and has a note that also limits N, the number
of full strain cycles, to no more than 2 million. The values for f are
conveniently listed in Table 302.3.5 for those not wanting to crank
through the equation. We display this table in our help text: less than
7000 cycles (roughly, once a day for 20 years) f=1, between 7000
and 14000 cycles f=0.9, and so on, to the limit of f=0.3 for 2 million
cycles.
So what’s new in 2004? First, f has a new name. In place of stress
range reduction factor, f is now termed the stress range factor.
That’s because f now has an upper limit of 1.2 so there’s not much
reduction going on if f is greater than 1.0. Notice how the theoretical
shakedown limit is 1.5 times the (Sc+Sh) sum and the Code limit is
1.25 times the (Sc+Sh) sum? By allowing f to increase to 1.2, the
resulting allowable stress is back to 1.5 times the sum. Using (1c),
you can back-calculate the number of cycles associated with f=1.2.
That value is 3125 cycles. So, this upper limit of f=1.2 is valid for
3125 or fewer cycles. There are limitations to using this higher f.
These limitations address the reduced fatigue life for high strength
steels and restrictions regarding nonferrous materials and materials
operating in the creep range. You cannot take f>1.0 in setting SA if:
1) the specified minimum tensile strength of the material is
greater than 75ksi,
2) Sc & Sh are greater than 20ksi in calculating SA,

B31.3 – 2002 300(c)(3) “Engineering requirements of this Code,
while considered necessary and adequate for safe design, generally
employ a simplified approach to the subject. A designer capable of
applying a more rigorous analysis shall have the latitude to do so;
however, the approach must be documented in the engineering
design and its validity accepted by the owner…”
1

3) the material is not ferrous or 4) the material operates in the
creep range (T>700F). None of these limitations apply if
you keep f ≤ 1.0 .

I have also seen references to the Goodman line and its fatigue
stress adjustment to explain the SL reduction.
3

A good example is the calculation of longitudinal (sustained) stress
in B31.3. There is no explicit formula provided for this stress and
official Code Interpretations regarding the use of stress intensification
have varied in the past.
2

Paragraph 302.3.2(d) sets Sc & Sh for typical piping materials and
302.3.2(d)(2) defines the 2/3 SY limit.
4
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The high cycle limit of 2 million has also been extended. The new
f goes out to 100 million cycles or what’s referred to as “an
indefinitely large number of cycles”. You may want to call that point
the fatigue endurance limit even though the Code Committee chose
not to introduce new terms here. The stress range factor at this large
number of cycles is 0.15. This matches well with the fatigue limits
defined in API Standard 618 (Reciprocating Compressors for General
Refinery Services) and ASME OM-3 (Pre-operational and Initial
Startup Vibration Testing of Nuclear Power Plant Piping Systems).
You may ask, “Why the interest in so many cycles since 100 million
over 20 years gives over 13,000 cycles a day?” While you may not
see many new land-based process plants on the drawing boards,
there’s a big business in FPSO (floating production, storage and
offloading) systems. On top of the normal thermal cycles, this
shipboard piping also experiences the deflections due to the hog and
sag of the vessel itself and the inertial loads caused by pitch and roll.
One hundred million doesn’t sound so big when you’re counting
waves.
One last thing to be said about this new f: in a nod to the ubiquitous
computer, the quick reference Table 302.3.5 is now gone. No more
stair stepped values for f. It’s just the equation and its companion
plot:
Comparison of B31.3 Cyclic (Reduction) Factors
1.3
1.1
0.9
f

f new

0.7

f old (Table)

0.5
0.3
0.1
1.E+03

1.E+04

1.E+05

1.E+06

1.E+07

1.E+08

Numbe r of Cycles

Operating Stress and Alternative Rules
A common question from a user unfamiliar with the Code’s stress
categories and modes of failure is, “Where’s the allowable stress
comparison for the operating load case?” We usually recite the
difference between load-based primary failure limited by yield and
displacement-based secondary failure limited by fatigue and how
the operating stress is not a measure of either. The 2004 edition now
has an allowable limit for operating stress in the new Appendix P.
This will make our explanations a little more complicated.
Appendix P is titled Alternative Rules for Flexibility Analysis and
addresses some of the finer points of analysis in the computer age,
namely, the evaluation of stress in piping systems in the presence of
nonlinear effects such as support liftoff. CAESAR II’s +Y restraint
is an easy concept to grasp, but it’s very elusive in terms of codedefined stress evaluation. The pipe is free to lift off the support
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(Y is vertical in this example), but it is restrained from moving down.
Early piping programs (in the early 70’s) were totally linear. They
had no liftoff capability and the pipe was either free or fixed for all
load cases. The linear nature of these tools kept things simple – the
expansion stress range was simply the thermal loads plus imposed
displacements analyzed alone (T1+D1). The first release of
CAESAR II had nonlinear supports and correctly calculated the
displacement stress range as the difference between the any two
states5, usually the operating case minus the installed case or L1-L2
in CAESAR II lingo. These nonlinear effects can be troublesome
when results from different support configurations need to be
combined. For example, how does one handle the situation where
the active support configuration changes between the installed case
and the operating case? CAESAR II will calculate the proper
expansion stress range, but the expansion allowable limit (in the
Code’s equation 1b shown above), with its “-SL” term, may be based
on a different treatment of that +Y support. Some may consider that
unconservative. As the active support configuration changes from
one state to the next, it is not always clear which state to use in range
calculations and their design limits. Appendix P addresses this issue
by not mixing states and ranges.
Appendix P is not mandatory and it does not supersede the
existing stress evaluation. What it does is replace one stress check
with another; one that may uncover overstress conditions that may
be lost in the state/range load case shuffle. So what are the
alternatives? You EITHER run the current expansion stress range
calculations, OR you run the new calculations. Like the base Code,
Appendix P checks stress ranges between any two “states” of the
piping system (e.g. the range of stress between installation and
operation), but it also provides a check for any individual state of
stress. Appendix P requires that the largest of these calculations
(ranges and states) be less than 1.25 f ( S c + S h ) . Again; all expansion
stress ranges and all operating stress states must lie below their
respective limits. Note that SL is missing from this allowable limit.
The expansion case was always more critical than the sustained
case since sustained stresses could always be addressed by wall
thickness and support spacing rules. Today, though, the sustained
stress seems to be a more interesting issue to some. In fact there is
a Code Inquiry asking which support configuration should be used
to evaluate sustained stress, and the response is that all possible
support configurations should be checked. So, if a pipe rests on a
support in the installed state but lifts off the support in any operating
state, the sustained stress should be evaluated both with and without
that support. CAESAR II, by default, checks only the installed case
assuming any liftoff is a secondary effect and is considered in the
expansion stress evaluation and any yielding here would be
shakedown. You could rerun each plausible sustained stress
calculation for each support configuration but a bolder approach
would be to turn it all into a single analysis where the sustained stress
case is a combination of each operating state minus the thermal
range, or (W+T1+P1+D1)-(T1+D1); then (W+T2+P2+D2)(T2+D2); and so on.
5
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It’s now included on the other side of this equation so that the ratchet
check (mentioned in the Stress Range Reduction Factor above) is
maintained with the operating state stress check.

Items such as pressure stiffening, longitudinal pressure formulation
and intensification of moments in sustained stress calculation are all
explicitly defined here.

Appendix P has a few other interesting points. The stresses
calculated here explicitly include an axial term. The base Code
calculation of expansion stress consisted solely of bending and
torsion. Now the range and state stresses follow

(S

2
+ S b ) + 4S t ;
2

a

where Sa, Sb & St are intensified axial stress6, bending stress and
torsion stress, respectively. Also, cold spring considerations are
tuned up. The base Code allows credit for only 2/3 of a cold spring
in calculating initial installation and operating loads on equipment
as the exact cut short (or long) cannot be assured. Here, that
uncertainty is extended to include an overzealous cut. Appendix P
requires examination of 2/3’s of design cold spring and 4/3’s of
design cold spring. This is not a problem in CAESAR II because a
user can set the design cold spring in the input and run two cases:
W+T+P+.67CS and W+T+P+1.33CS. And, new in Version 5.0,
you can assign a temperature-based Young’s modulus to the analysis.
Once again, the Code gives a nod to the current capabilities of
computer analysis.
Sample Analysis
B31 3 has another new appendix, Appendix S, which illustrates the
application of Code rules in stress analysis. Work started a few years
ago with a few common problems in stress analysis such as sustained
stresses with support lift off and expansion stress ranges with
moment reversals (where a hot leg / cold leg switch causes a greater
stress range that a general installed-to-operating case). But, there
were so many unanswered or unaddressed basic issues in system
stress analysis that the Code committee could not resolve these
meatier questions until the basic concepts were defined. Some may
call it dumbing down or oversimplifying the appendix, but it is more
of a solid base from which the Code can build. To review all the
considerations addressed by today’s pipe flexibility and stress
analysis programs is a daunting task and quite an accomplishment
for a committee.
The first model presented in Appendix S is a simple code-compliant
system; a planar Z bend of constant cross section, no branches, two
anchors and a single (linear) Y support. Of course it’s a “dull”
system, but it sets the groundwork for the future. For one, it sets all
“flags” required for the analysis. The configuration settings
CAESAR II give an idea of the possible switch settings. Most use
default settings but this document cannot rely on vendor defaults.

The appendix also runs through a few other calculations or checks
before moving on to model input and output and here is where more
subtle value exists including a definition of design conditions and
analysis conditions, two conditions which may not be identical.
Here, too, a second temperature case below the ambient temperature
is included. Of course, a wall thickness check for pressure must also
be examined before running the analysis. The complete process of
setting the minimum wall thickness requirement to checking the
actual wall is reviewed.
The model is quite simple and the analysis is almost trivial, but first,
a few basic issues had to be settled. For one, a complete stress
evaluation would include sustained stresses. So, the code committee
took the text in paragraph 302.3.5(c)7 and converted it to an explicit
equation. Questions such as stress intensification and the pressure
stress formulation had to be answered. One outcome of this exercise
is the proposed B31.3 sustained stress Code Case described below.
Including a temperature below ambient made the expansion stress
range calculation a little more interesting. CAESAR II users cannot
depend on the recommended load cases to produce the same results.
CAESAR II recommends (operating case 1 – installed case) and
(operating case 2 – installed case) but not (operating case 1 –
operating case 2)8. It us up to the user to build the overall strain range
calculation in CAESAR II. (See M.E.N. May 1993 and July 2003
for details on this procedure.)
“The sum of longitudinal stresses in any component in a piping
system, due to pressure, weight, and other sustained loadings SL
shall not exceed Sh in (d) below.”
7

Since this system is linear, T1 is identical to (W+T1+P1)-(W+P1)
and T2 is identical to (W+T2)-(W). Additionally, since the system
is planar, (W+T1+P1)-(W+T2) is identical to the sum of the results
of T1 and T2. This will not be true in 3D systems.
8

The intensification factor is 1.0 for elbows and io from Appendix
D for other components.
6
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The results from three commercial pipe stress programs were used
in compiling the results tables. If all the analysis flags are properly
set in CAESAR II, your numbers should fall within the stated
tolerances. Note that enough tolerance had to be included in the
results to allow for the varying round off between metric and U.S.
customary input units. The input, configuration, load case and
output files for the CAESAR II run of this job can be downloaded
from the COADE web site. (Download S_1_SI.zip (for SI units) and
S_1_US.zip (for US Imperial units) from the
CAESAR II file section.)
Other things
Short term occasional stress allowable in creep range
In accordance with paragraph 302.3.2, the basic allowable stress for
some high temperature materials is limited by creep strength (“100%
of average stress for a creep rate of 0.01% per 1000 hr”) rather than
yield strength at temperature (“two-thirds of yield strength at
temperature”). Allowable stress controlled by creep places an
unnecessary restriction on occasional stresses. Occasional loads are
similar to sustained loads in that they are forced-based stresses as
opposed to strain-based stresses and they have collapse as their
mode of failure. While sustained loads are long term and creep is
an issue, occasional loads are temporary so creep is not an issue.
Therefore, B31.3 has removed the creep strength restriction from
evaluating the sum of stresses due to sustained loads and stresses
due to occasional loads. B31.3 has replaced the limit of kSh with up
to 90%9 yield strength at temperature (as listed in the BPV Code,
Section II, Part D, Tables Y-1 or Y-3). So, if you have high stress
issues with occasional load evaluation, the Code may now accept as
safe your higher stresses. This update replaces kSh but does not alter
the value of Sh used in setting kSh as the allowable stress for
sustained plus occasional loads.
Weld Joint Strength Reduction Factors
In elevated temperature considerations, engineers have observed
that the strength of weld metal does not match that of the base metal
at creep temperatures. This concept is applied as an additional
factor in the pressure thickness equations, similar to the weld joint
efficiency. Accordingly, all wall thickness (hoop strength)
calculations have been modified for welded (not seamless) pipe and
welded components. This consideration also plays a role in the
sustained stress evaluation of the piping system. The pipe’s allowable

The variability (72% to 90%) represents the reduction in the long
term strength of the material at elevated temperatures. Use 90%
times yield for austenitic stainless steels (which do not suffer from
this aging) and 72% (actually, 0.8 ⋅ 90% ) for other materials.
9
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stress limit (Sh) must also be multiplied by this weld joint strength
joint reduction factor, W. This factor does not affect occasional or
expansion stresses10. The weld strength reduction factor is the ratio
of stress causing failure in the weld material to that of the base metal.
Without your own creep data, set W=1 for temperatures up to 510°C
(950°F) and drop linearly to W=0.5 at 815°C (1500°F). You are on
your own above 815°C. This concept is applied as an additional
factor in the pressure thickness equations, similar to the weld joint
efficiency. The application of this factor as a reducer of allowable
stress rather than an increaser of calculated stress is awkward. Up
until this point, the allowed limit for sustained stress came directly
from Appendix A, and an engineer need not locate girth butt welds
in the stress analysis. That is no longer the case in elevated
temperature piping. CAESAR II does not directly address this weld
joint strength reduction.
Code Case defining Sustained Stress
This change is not a 2004 edition per se. Work on this topic grew
out of the Appendix S effort. The Code Committee found itself in
an odd position when it tried to present an application of commercial
stress analysis. Up until this time, the formula for sustained stress
was left to the judgment of the individual designer (see paragraph
302.3.5(c)). Any sustained stress used in the Appendix would
become the de facto standard simply because it was exercised in the
B31.3 document. The sticking point lay in the use of a stress
intensification factor in the sustained stress. The two previous Code
Interpretations (1-34 from 1981 and 6-03 from 1984) expressed
different views11. The worked example in Appendix S avoided the
issue by keeping the highest sustained stress away from the intensified
elbows. Because the issue was already raised, the task group
responsible for this work took the steps necessary to generate
consensus in the Code Committee. The work was finished too late
for the 2004 Edition so, rather than waiting until 2006, this item was
instead proposed as a Code Case. Code Cases are not Edition
specific so, as passed, the Code Case can go right to the public for
immediate use. This change, written as

, will

be published on the ASME web site when it’s official. Terms are the
same as defined above, but, here the axial stress is not intensified and
the bending moments for all components are adjusted by 0.75i or
1.00, whichever is greater.
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It does raise a question though: If σ sus ≤ W ⋅ S h must be maintained;

is the simpler σ sus + σ occ ≤ k ⋅ S h still valid?
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Keeping up to date
Strangely, ASME does not notify all purchasers of the previous
Code when a new edition is released. When I buy new editions, I ask
them to alert us to the new code. However, it’s up to you to regularly
monitor the new publications list. I recommend that you bookmark
the ASME web site at www.asme.org. Remember, B31.3 is on a two
year cycle and, while no Addenda are issued, Errata will be posted
on the B31.3 web site. You will also find draft documents for
comment and Code Interpretations there.

PC Hardware/Software for the
Engineering User (Part 35)
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CAESAR II Notices
TANK Notices
CodeCalc Notices
PVElite Notices
Previous editions of this newsletter contained a list of software
errors and omissions for all of our engineering products. In an
effort to provide this information in a more timely manner, and to
synchronize this information with specific software releases and
updates, these lists have been made available on the COADE
website, in the download area for each product. These lists will no
longer be printed in this newsletter.

File Open Confusion
Recently COADE has received a number of calls and e-mails
describing a problem with the “File Open” dialog box. The
problem is that the files are no longer in alphabetical order, they
appear completely random. This makes finding a specific file
difficult, if not impossible in a highly populated directory. What is
the solution to this problem?
Actually the solution to this problem is rather simple – it is a
“Windows Explorer” setting. To change the setting so that files
appear alphabetized in “File Open” dialogs, start Windows Explorer.
Pull down the “View” menu, and expand the “Arrange Icons by”
option. When this sub-menu expands, click on “Name”. Now, the
“File Open” dialogs will behave as expected.
You can also access this setting by “right clicking” in the “File
Open” dialog box. From the resulting context menu, select the
“Arrange Icons by” option.
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